
 

Instructions to operating forms created in 
MSWord and Excel 

 

 

Page 1 of 5                                                                                         MS Instructions (12/08) 

Forms created in MSWord and Excel can contain macros. In order for the form to work correctly, your 
MSWord/Excel security level must be set at “Medium” and you must not operate the form via a browser (internet 
explorer) or an email system (GroupWise).  MSWord/Excel does not work properly when opened via other 
applications. See page 3 for tips on working in MSWord and Excel with interactive fields. 
 
Please use the following directions: 
 
1)  While you are in the browser (Internet Explorer), double click on the link “Word” or “Excel” (this opens 

the form via the browser). To download the form to your desktop, choose "Save As", choose the path to 
your desk top and save to your desktop. Be sure to save the file extension as it currently appears, .dot, 
.doc, or .xls.  This will insure that macros in the document will function properly.  You can tell what kind of 
file it is by looking at the extension once it is opened up. 

 
2)  Once you have saved to your desk top,  close your browser (Internet Explorer).  

Open the document from your desk top, double click on the icon that is on your desk top. You should get a 
“Security Warning Box” and it will state the following:  

“Macros may contain viruses. It is usually safe to disable macros, but if the macros are legitimate, you 
might lose some functionality.” 

 The box will have three (3) choices; 1. Disable Macros   2. Enable Macros   3. More Info  
             Choose “Enable Macros” 
 
At this point if you did not get this exact “Security Warning Box” you may get another Security Warning box 
telling you the macros in this document have been disabled. If you get no box what so ever, this means your 
security level is set too high for the macros to work. 
 
3)  Now you will need to change the “Security Level” of MSWord.  
 To change security level in MSWord 2000 or 2003: 
 
  A)  Open MS Word, the application only, not the document. 
  B)  From the "Tools" menu, select Macros/Security/ and check “Medium” on the “Security Level” tab. 
  C) Close out MSWord 

D)  Double click the icon on your desk top. 
 

If you have MSWord 2007 the process to change the security level is different. Follow these steps to change the 
macro security level in the “Trust Center” (See information on Trust Centers on page 3): 

How do you change macro security settings for all documents in the Trust Center? 
Macro security settings are located in the Trust Center. However, if you work in an organization, your system 
administrator might have changed the default setting and prevented you from changing any settings. 
 NOTE   When you change your macro settings in the Trust Center, they are changed only for the Office program 
that you are currently using. The macro settings are not changed for all your Office programs. 

1. Click the Microsoft Office Button , and then click Word Options.  
2. Click Trust Center, click Trust Center Settings, and then click Macro Settings.  
3. Click the options that you want:  
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 Disable all macros without notification Click this option if you don't trust macros. All macros 
in documents and security alerts about macros are disabled. If there are documents with unsigned 
macros that you do trust, you can put those documents into a trusted location. Documents in trusted 
locations are allowed to run without being checked by the Trust Center security system.  

 Disable all macros with notification This is the default setting. Click this option if you want 
macros to be disabled, but you want to get security alerts if there are macros present. This way, you can 
choose when to enable those macros on a case by case basis.  

 Disable all macros except digitally signed macros This setting is the same as the Disable all 
macros with notification option, except that if the macro is digitally signed by a trusted publisher, the 
macro can run if you have already trusted the publisher. If you have not trusted the publisher, you are 
notified. That way, you can choose to enable those signed macros or trust the publisher. All unsigned 
macros are disabled without notification.  

 Enable all macros (not recommended, potentially dangerous code can run) Click this option 
to allow all macros to run. This setting makes your computer vulnerable to potentially malicious code and 
is not recommended.  

 Trust access to the VBA project object model  This setting is for developers and is used to 
deliberately lock out or allow programmatic access to the VBA object model from any Automation client. 
In other words, it provides a security option for code that is written to automate an Office program and 
programmatically manipulate the Microsoft Visual Basic for Applications (VBA) environment and object 
model. This is a per user and per application setting, and denies access by default. This security option 
makes it more difficult for unauthorized programs to build "self-replicating" code that can harm end-
user systems. For any Automation client to be able to access the VBA object model programmatically, 
the user running the code must explicitly grant access. To turn on access, select the check box.  

 TIP   You can open the macro security settings dialog box from the Developer tab in the Ribbon, which is part of 
the Microsoft Office Fluent user interface. If the Developer tab is not available, click the Microsoft Office 

Button , and then click Word Options. Click Popular, and then select the Show Developer tab in the Ribbon 
check box. 

 
 
4) You should now get the proper “Security Warning Box” when you open the document. Be sure to “Enable 

Macros” when you get the “Security Warning Box”. 
 
5)  If  you are opening a document with a “.dot” extension, you should get a pop-up prompt box, this is called a 

“User Form”. Fill this out and hit the O.K. button at the bottom of the “User Form” All the information will 
flow into the form and your curser will be in the first “fill in” interactive field. Hit the tab button and you 
will go from field to field until all fields have been completed. 

 
 If you open a MSWord document with a “.doc” or the excel document with a “.xls” extension, your cursor 

will be in the first “fill in” interactive field. Hit the tab button to go from field to field until all fields have 
been completed. 

 
6) Remember when you are done filling out your form, you must use the “Save As” function and rename your 

document so you don’t wipe out your original template (This is most important for the “.dot” documents) or 
you will have to down load another copy. 
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Tips on using a MSWord document with interactive fields 
 
In order for an interactive field to function properly in MSWord the area the field is in must be locked. This 
allows check boxes to work, drop down choices to appear and the text boxes to work properly. Sometimes there 
are links to other documents in a MSWord document, in order for the link to work the area the link is in must be 
unlocked. This can cause confusion when tabbing from one interactive field to another before and after the link. 
You can tab into the link from an interactive field before the link, however to get to the first interactive field 
after the link, you must use the cursor and place it in the first interactive field after the link, then you can 
continue to tab from interactive field to interactive field. 
 
When you have an interactive field in a MSWord document that is repeated several times in the document, there 
are place holders throughout the document for the data to transfer, however the transfer will not take place until 
you do one of two things;  
 

1. Choose file “Print Preview” or 
2. Choose file “Print” 

 
Once you have done one of those two things the data will have transferred and will appear throughout the 
document where the place holders instruct it to go.  If you need to fill out the document with another individual’s 
information, repeat one of the two steps and the data will be updated. 
 
 

Tips on using an Excel document with interactive fields 
 
When you are working in an Excel document that has locked cells and unlocked cells, with drop down fields, you can 
tab from each unlocked cell to another unlocked cell and into a drop down field from an unlocked cell, but you 
cannot tab out of the drop down field, you must use your cursor to get to the next field. 
 
See page 3 for information on MSWord 2007 “Trust Centers” 
 
Should you have any problems or questions, please call Paula Hansen at 503-378-3464, Lynette Sylvester at 503-
378-3505, or Eva Canoy at 503-378-3457. 
 

Additional Information on MSWord version 2007. 
Enable or disable macros in Office documents via “Trust Centers” 
This article is about macro security and explains the risks involved in enabling macros and how the Trust Center in 
the 2007 Microsoft Office system can help to mitigate these risks. In this article, the term "document" can mean 
any Microsoft Office file that can contain macros. The term "macro" means a macro created by using Visual Basic 
for Applications (VBA) (Visual Basic for Applications (VBA): A macro-language version of Microsoft Visual Basic 
that is used to program Microsoft Windows-based applications and is included with several Microsoft programs.) 

What is a macro and what is the security risk? 
The purpose of a macro is to automate frequently used tasks. Although some macros are simply a recording of your 
keystrokes or mouse clicks, more powerful VBA (Visual Basic for Applications (VBA): A macro-language version of 
Microsoft Visual Basic that is used to program Microsoft Windows-based applications and is included with several 
Microsoft programs.) macros are written by developers who use code that can run many commands on your 
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computer. For this reason, VBA macros pose a potential security risk. A hacker can introduce a malicious macro 
through a document that, if opened, allows the macro to run and potentially spread a virus (virus: A computer 
program or macro that "infects" computer files by inserting copies of itself into those files. When the infected 
file is loaded into memory, the virus can infect other files. Viruses often have harmful side effects.) on your 
computer. 

How can the Trust Center help protect me from unsafe macros? 
Before allowing a macro to be enabled in a document, the Trust Center checks for the following: 

 The macro is signed by the developer with a digital signature (digital signature: An electronic, 
encryption-based, secure stamp of authentication on a macro or document. This signature confirms that the 
macro or document originated from the signer and has not been altered.).  

 The digital signature is valid (valid: Refers to the status of a certificate checked against a certificate 
authority's database and found to be legitimate, current, and not expired or revoked. Documents signed by a 
valid certificate and not altered since signing are considered valid.).  

 This digital signature is current (not expired).  

 The certificate associated with the digital signature was issued by a reputable certificate authority 
(CA) (certificate authority (CA): A commercial organization that issues digital certificates, keeps track of 
who is assigned to a certificate, signs certificates to verify their validity, and tracks which certificates are 
revoked or expired.).  

 The developer who signed the macro is a trusted publisher (trusted publisher: The developer of a macro 
that is trusted by you on your computer. The trusted publisher is identified by the certificate that they used 
to digitally sign the macro. Also known as a trusted source.).  

If the Trust Center detects a problem with any of these, the macro is disabled by default, and the Message Bar 
appears to notify you of a potentially unsafe macro. 

 

If you click Options on the Message Bar, a security dialog box opens, giving you the option to enable the macro. See 
the next section for how to make a secure decision before you click an option. 
 NOTE   In Microsoft Office Outlook 2007 and Microsoft Office Publisher 2007, security alerts appear in dialog 
boxes, not in the Message Bar. 

What should I do when a security warning asks if I want to enable or disable a macro? 
When a security dialog box appears, you have the option to enable the macro or leave it disabled. You should enable 
the macro only if you are sure it is from a trustworthy source. 
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 IMPORTANT   If you are sure the document and macro are from a trustworthy source and have a valid signature, 
and you do not want to be notified about them again, instead of changing the default Trust Center settings to a 
less safe macro security setting, you can click Trust all documents from this publisher in the security dialog box. 
This adds the publisher to your Trusted Publishers list in the Trust Center. All software from that publisher is 
trusted. In the case where the macro doesn't have a valid signature, but you trust it and don't want to be notified 
again, instead of changing the default Trust Center settings to a less safe macro security setting, it is better to 
move the document to a trusted location. Documents in trusted locations are allowed to run without being checked 
by the Trust Center security system. 
 


